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How To Post Grades Online 
 
1) NOTES:  Only the instructor of record will be granted access to posting grades 
online.  At this time, administrators, department chairs or anyone other than the 
instructor of record will be denied access to posting grades for a class that is not theirs.   
 
2) Go to: http://marlin.laccd.edu/district/grants_and_programs/instructors.htm  
 
3) Click on "assign grades to students."   
 
4) Enter your DEC User ID (In most cases, this is the first 6 letters of your last name, or 
fewer letters if your entire last name is less than six letters, followed by your first initial 
and, if you have one, your middle initial. – Example:  the DEC User ID for John Q. 
Public would be PUBLICJQ.  
 
5) Click on the blue “OK” button (pressing “Enter” or the “Return Key” will NOT work!)   
 
6) Enter your DEC Password - If you are a current DEC user, you already have a 
password that will also work for this purpose.  
- If you are NOT a current, authorized DEC user, use your employee number for your 
DEC password.  
- If neither of the options above allows you to continue, contact Management 
Information Systems (MIS) in A102, ext. 437, to obtain an Information System Access 
Request and Agreement form.  
 
7) Click on the blue “OK to proceed to the instructor menu” button.   
 
8) On the next available screen, follow the instructions to select the College, Year, and 
Semester of the class for which you want to submit grades.   
 
9) Click on the blue “OK” button.   
 
10) Enter the specific section number of the class containing the student(s), and the 
sequence option to display the student information.   
 
11) Click the blue “OK" button to submit the request.   
 
12) The next screen you see should be your students and directions on how to post 
grades.  You must enter a grade for every student in the class for the process to work.  
If you want to give a student an incomplete, you need to enter "I" in the grade column 
and enter a default letter grade in the second column.  When you have given every 
student a grade, click on the OK button at the bottom of the page.   
 
13) After a few seconds, the computer will return with the results of your submission.  It 
will list all of the students in your class along with the grades you wanted to give them.  
Or it will tell you what errors you need to correct.  Once you have succeeded in giving 
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all students their grades, there will be directions to PRINT the page, SIGN it and submit 
it to the registration office.  You can staple that printed form to the normal grade sheet 
and submit them together to Registration.  Do not bubble in the normal grade form if you 
submit grades electronically.   
 
14) You may then chose to view another course roster or exclude students, or submit 
grades for another class or exit the system.  
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How To Access Class Rosters Online 
 
1) NOTES:  Only the instructor of record will be granted access to a class roster online.  
At this time, administrators, department chairs or anyone other than the instructor of 
record will be denied access to class rosters online.   
 
2) Double-click on either Internet Explorer or Netscape icon from your Windows 
Desktop.   
 
3) Go to:   http://marlin.laccd.edu/district/grants_and_programs/instructors.htm  
 
4) Follow the instructions listed to click on the “Instructor System” button   
 
5) Enter your DEC User ID (In most cases, this is the first 6 letters of your last name, or 
fewer letters if your entire last name is less than six letters, followed by your first initial 
and, if you have one, your middle initial. – Example:  the DEC User ID for John Q. 
Public would be PUBLICJQ.   
 
6) Click on the blue “OK” button (pressing “Enter” or the “Return Key” will NOT work!)   
 
7) Enter your DEC Password   -     If you are a current DEC user, you already have a 
password that will also work for this purpose.   
- If you are NOT a current, authorized DEC user, use your employee number for your 
DEC password.   
- If neither of the options above allows you to continue, contact Management 
Information Systems (MIS) in A102, ext. 437, to obtain an Information System Access 
Request and Agreement form.   
 
8) Click on the blue “OK to proceed to the instructor menu” button.   
 
9) On the next available screen, follow the instructions to select the College, Year, and 
Semester of the class roster you desire.   
 
10) Click on the blue “View Roster” button.   
 
11) Enter the specific section number of the roster you wish to view and, if desired, a 
sequence option to display the requested information.   
 
12) Click the blue “OK to submit the request” button.   
 
13) The next screen you see should be your requested roster.  You may click on the 
“Print” button to print out a hard copy.   
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How To Exclude Students Online 
 
1) NOTES:  Only the instructor of record will be granted access to exclude students 
online.  At this time, administrators, department chairs or anyone other than the 
instructor of record will be denied access to exclude students online in classes other 
than their own.  Also, you will only be allowed to exclude students if you do so within the 
normal time frame allowed each semester and for your specific class.   
 
2) Go to:   http://marlin.laccd.edu/district/grants_and_programs/instructors.htm  
 
3) Click on the "Exclude Students from classes" link.   
 
4) Enter your DEC User ID (In most cases, this is the first 6 letters of your last name, or 
fewer letters if your entire last name is less than six letters, followed by your first initial 
and, if you have one, your middle initial. – Example:  the DEC User ID for John Q. 
Public would be PUBLICJQ.   
 
5) Click on the blue “OK” button (pressing “Enter” or the “Return Key” will NOT work!)   
 
6) Enter your DEC Password   -     If you are a current DEC user, you already have a 
password that will also work for this purpose.   
- If you are NOT a current, authorized DEC user, use your employee number for your 
DEC password.   
- If neither of the options above allows you to continue, contact Management 
Information Systems (MIS) in A102, ext. 437, to obtain an Information System Access 
Request and Agreement form.   
 
7) Click on the blue “OK to proceed to the instructor menu” button.   
 
8) On the next available screen, follow the instructions to select the College, Year, and 
Semester of the class containing the student(s) you want to exclude.   
 
9) Click on the blue “Exclude” button.   
 
10) Enter the specific section number of the class containing the student(s), and the 
sequence option to display the student information.   
 
11) Click the blue “OK" button to submit the request.   
 
12) The next screen you see should be your students and directions on how to exclude 
them.  You must enter the date of exclusion EXACTLY as it shows at the top.  You can 
exclude as many students as you want at the same time.  When you have entered the 
dates for all of the students you want to exclude, you need to click on the "OK" button at 
the bottom of the page.   
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13) After a few seconds, the computer will return with the results of your submission.  It 
will list all of the students you wanted to drop with a **SUCCESSFUL** status next to 
their name or it will tell you what mistakes you need to correct before the process can 
conclude.  If you were successful, it gives directions to PRINT the page, SIGN IT, and 
submit it to the Registration Office.  It is very important to our campus audit process that 
you submit that paper in a timely manner.   
 
14) You may then chose to view another course roster or exclude students from another 
class or exit the system  
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Creating & Publishing Your Homepage Using Netscape Composer 
 
To Create the index.html file 
 

1. Create a folder on the floppy disk and name it your first name. This folder will 
be used to assemble your Web Site files. 

 
2. You will be using a clip art image during this exercise. The proper procedure 

is to locate the image prior to using it. Browse through the Clipart folder (the 
Trainer will tell you where the folder is located) and choose one of the images 
to decorate your home page. Copy that image from the Clipart folder to your 
Web Site folder on the floppy disk. 
 
Now you are ready to work on the file. 

3. Open Netscape Composer and, if necessary, click the NEW button  to get 
a blank page. 

 
4. Use Save As from the File menu to save the blank page in your Web Site 

folder on the floppy disk. Use the file name index.html 
 

5. It's time to give your page a title. Windows users will automatically be given 
an opportunity to title the page at this time. To title the page using a 
Macintosh, choose Page Title from the Format Menu. You should use the title 
Home Page to describe the function of this initial page. The title will be 
displayed when the page is accessed on the Web.  

 
To Create a Table That Can be Used to Control Text and Image Spacing 
 

1. Click the TABLE button.  A dialog box will appear. This dialog box is used 
to set the table's properties. For now you will use the defaults. Later on you 
can experiment with changing them if you wish. The default settings are: 

 
1 Row and 2 Columns; Border Line Width = 1 pixel 
Spacing between Cells = 1 pixel; Padding within Cells = 1 pixel 
Table Alignment = Left; Table Width = 100% of window 
Equal Column Widths 

 
2. Click the OK button to accept the defaults. You will see an outline of the 

empty table on the page. 
 
To Insert Text into a Table Cell 
 

1. Click to place the insertion point in the first cell (row 1, column 1) and type the 
following in that cell. Use the RETURN (ENTER) key to move from one line to 
the other. Note how the table cell changes size to accommodate what you 
type. 
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Your Name 
Your Academic Department 
Your College's Name 
Name of the City where your College is located 

 
2. Change the appearance of the text as you please by using the Format menu.  

Another way to format text in Netscape Composer is to use the drop down list 
of pre-set paragraph styles on the left side of the tool bar. 

 

   
 

There are six different heading styles ranging in size from Heading 6 (the smallest) to 
Heading 1 (the largest). The other styles shown in the drop down list are either self-
explanatory or their effect can be found in Netscape Communicator's Help section 
under "Paragraph Styles". 
 
You can control the color of the text by clicking the color button on the toolbar 
of the Macintosh  or by using the drop down Font Color list on the 
Windows machine. 
 
Use the Horizontal Line button  to insert a divider line anywhere in the 
text.  

 
To Insert a Graphic Image 
 

1. Click to place the insertion point in the second cell (row 1, column 2) in 
preparation for inserting the image you previously selected. 

 

2. Click the IMAGE button  The Image Properties dialog box will be 
displayed. 
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3. Click the Choose Files button. The Choose Image File dialog box will be 
displayed. 

 
4. Locate and select the filename for the desired image. (It will be in your site 

folder.) 
 

5. Click the Open button. The Image Properties dialog box will reappear. You 
will use this dialog box at this time to specify text that will appear while the 
image is being loaded. The specified text would also be displayed if, for any 
reason, the image cannot be displayed to a user. 

 
6. Specify alternate text as follows: 

 
Windows Users - 

a. Click the ALT TEXT/LOW RES. button to bring up the Alternate 
Image Properties dialog box. The insertion point should be blinking 
in the Alternate Text box. 

b. Type: Home Page Image 
c. Click the OK button 

 
Macintosh Users - 

a. Click to set the insertion point in the Text box of the Alternative 
Representations section of the dialog box. 

b. Type: Home Page Image 
 

7. The other options in the Image Properties Dialog Box will not be used at this 
time. Most of them are self explanatory, with the possible exception of the xyz 

Text Alignment buttons  (drop down menus on the Macintosh). Those 
buttons control how the image will appear relative to any adjacent text. 

 
8. Click the OK button on the Image Properties dialog box to complete the 

image insertion procedure. 
 

9. Save the file. 
 
To Change the Size of the Image 
 
It may be that the image you selected is too small (or too large) to fit into the available 
space. If so, you can change its size (in Netscape Composer) as follows. 
 

1. Click to select the image. 
 

2. Click the Image button on the toolbar to bring up the Image Properties dialog 
box. 
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The Dimensions section of the dialog box shows the current size of the 
image. 

 
3. On the Macintosh, click the Custom Size option (not necessary on Windows). 

You have two resizing options - you can either resize the image keeping its 
original proportions, or you can skew it out of proportion. To maintain the 
proportions, click to put a check mark in the Constrain box and then change 
the pixel size for either dimension. The other dimension will also change to 
maintain the original proportions. To skew the image, remove the check mark 
from the Constrain box and change the pixel size for either or both 
dimensions. 

  
To Complete the Text for Your Home Page 
 

1. Click to place the insertion point immediately below the table and type the 
current term on the first line, your course schedule on the following lines, with 
information about how to contact you on the final lines. Your typing may look 
something like this: 

 
Winter 2000 Course Schedule 
 
MIL1  8:30 am 
Office  9:30 am 
MIL 3  10:30 am 
MIL 8  11:30 am 
 
Office Phone: 123-555-9999 
Email:   teacher@school.edu
 

2. Format the course schedule as you please. 
 

3. When you have the appearance of the text to your liking, save the file; but do 
not close it. Your screen might look something like this. 
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To Publish the file to a Web Server 
 

1. You must be connected to an Internet Service Provider and the index.html 
file must be open in the Netscape Composer window. 

 
2. Click the PUBLISH button. The Publish Page Dialog Box appears. 

 
 

 
 

3. Fill in the location, username and password in the dialog box. 
 

4. Click the "All files in page's folder" radio button. 
 

5. Click the Select All button. 
 

6. Click the Publish button (Macintosh) or the OK button (Windows). 
 

7. Windows users:  If you see a Security dialog box, click the Continue button. 
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8. You should soon see a message that your file was uploaded successfully. 
 

9. Close the Netscape Composer window. 
 
To View Your Website 
 

1. Close and/or minimize all windows. 
 

2. Open Netscape Communicator. 
3. Type the URL for your homepage into the address window. 

 
Your new web page should soon be displayed 
 
Communication Styles  
 

• Students and faculty must be aware of different communication styles 
• Instructor must set the tone for email messages 
• Let students know at the beginning of class your policies regarding response 

time 
• Use “clues” to help convey the meaning of your messages 
• Clues refer to emoticons and acronyms 

 
Emoticons  
 

:-)   or   : )     Smiley (most common) 
;-)   or   ; )     Wink 
:-o  or   : o    Gasp 
:-(   or   : (  Unhappiness 
 

Acronyms 
 

BTW:  By the way 
IMO:  In my opinion 
IMHO:  In my humble opinion 
FAQ:  Frequently asked questions 
FYI:  For your information 
ROTFL:  Rolling on the floor laughing 
LOL:  Laughing out loud 
F2F:  Face to face 

 
Providing Feedback 
 

• Students like the instant feedback they are able to receive when using online 
tools to communicate 

• Instructors must set up their standards for responding to email 
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• Turn-around time 
• Different response time for different types of questions? 
• What are the standards for students? 
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Setting Up a Yahoo! Groups Account 

For your hands-on listserv, bulletin board, and chat activities, 
you will be using Yahoo! Groups, a popular site acquired in 
June 2000 by Yahoo! Your trainer has set up a Yahoo! 
Groups site for your course.  

HINT: If using this resource in your own classroom, you may 
want your students to initiate the subscription process 
themselves. We found it more efficient to obtain participants' 
email addresses and register them ourselves; this is the 
procedure used below. 

Trainer Tip:
 
If you are using 
participants' existing 
Yahoo! Mail account 
s (i.e. not dummy 
training accounts), 
note that your 

 
Prior to class time: 

1. Obtain and have handy the email addresses for all 
participants/students. 

NOTE: In a training session, you may wish to set up dummy 
Yahoo email accounts using generic names (Student 1, 
Student 2, etc.). Participants can use those dummy accounts 
during the course. 

2. Go to the Yahoo! Groups website at 

NOTE: 
 
At publication time, 
Yahoo! Groups had 
just taken over 
Yahoo! Groups, and 
changed the 
registration process.  
This may change 
again, so be aware 
that some of these 

http://groups.yahoo.com/ 

3. Sign up for membership in Yahoo! Groups.  (NOTE:  If 
you already have a Yahoo! Mail account, you simply 
need to follow the link under "Getting Started."  Follow 
the instructions there.) 
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4. Go to your email account and check your mail. You will 
receive a confirmation from Yahoo! Groups, which 
contains an authorization number. Follow the Yahoo! 
Groups directions and complete your registration using 
that authorization number.  

5. Once your authorization is complete, go to: 
http://groups.yahoo.com.  Click the Start a Group 
button to create a new group. You will need to give your 
group a unique name and supply some information about 
the group. We suggest that you restrict this site for your 
members only. 

6. The last step of registration asks you to register 
participants and create a Welcome Message which  

appears in their invitations: 
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7. Use the email addresses of the participants/students to 
subscribe them to the group, and check the second radio 
button to directly subscribe members.  Using this 
approach can save class management time. 

NOTE: The default method of sending invitations requires 
potential users to respond to the invitations before 
membership becomes active. 

8. When you are through, a congratulatory screen will 
appear confirming the information about your group, 
including its web address (for chat and bulletin board) 
and posting address (for listserv).  
 
Print this page for future reference. 

Participants will each receive a welcome message, which 
will include the name of the group, any personalized note 
you included, and instructions for using Yahoo! Groups.  
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Using PowerPoint 
 
This tutorial is unlike the others you have seen in class. The PowerPoint tutorial will be 
text based. To get the most out of this tutorial it is best to run PowerPoint, so that you 
can experiment with the concepts that are mentioned in the tutorial.  
 
Find and open PowerPoint.  
 
When the Tip of the day dialog box appears,  
Read it and click on the OK button.  
 
The following PowerPoint dialog box should appear, asking you how you want to 
create your new presentation.  
  
 
Here is a brief description of the options under the Create a New Presentation Using 
title.  
 
 
* AutoContent Wizard- takes you through the creation of a simple presentation 

step by step.  
 
* Pick a Look Wizard- this wizard helps you make choices on how your 

presentation will look.  
 
* Template- PowerPoint provides 160 templates that you can choose from. The 

templates are created by professional artists and offer design choices in black 
and white as well as in color.  

 
* Blank Presentation- this option allows you to select slides and format them 

individually.  
 
Select Blank Presentation and click on the OK button.  
 
In the New Slide dialog box select the Title Slide option.  
 
Your screen should look as follows:  
 
 
This is your title slide you can enter the title and sub-title here. Note that if your toolbars 
are not visible, choose Toolbars from the View menu and make your selections.  
 
Experiment with your title slide by entering in text, changing the color of the text, 
changing the font size etc.  
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Now that you have been introduced to a slide, it is time to learn about PowerPoint's 
different Views.  
 
Next Topic: Understanding PowerPoint Views  
Main Menu 
 
Screen Layout 
 
The Power Point screen layout in Normal View: 
 
Views 
 
Power Point gives you four screen layouts for constructing your presentation in addition 
to the Slide Show. You can select the page view by clicking the buttons just above the 
formatting toolbar and the bottom of the page. 
 
Normal View 
This screen is split into three sections showing the presentation outline on the left, the 
slide in the main window, and notes at the bottom.    
 
Slide View 
The slide view displays each slide on the screen and is helpful for adding images, 
formatting text, and adding background styles. 
  
Outline View 
The presentation outline is displayed on the majority of the screen with small windows 
for the slide and notes. This view is recommended for editing text.     
 
Slide Sorter View 
A small image of each slide is displayed in Slide Sorter view. Slides can easily be 
ordered and sorted from this screen. 
 
Click the Slide Show button to view the full-screen slide show. 
 
  
 
Insert a New Slide  
 
Follow these steps to insert a new slide into the presentation: 
 
* In the Outline window, select the slide you want the new slide to appear after by 

clicking the slide's number.  
* Select Insert|New Slide from the menu bar or click the new slide button on the 

standard toolbar. 
* Choose the page layout from the window and press OK. 
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Applying a Design Template 
 
To add a design template or changing the existing one, selection Format|Design 
Template from the menu bar. Select the template and click Apply. 
 
Changing Slide Layouts 
 
To change the layout template of the slide select Format|Slide Layout from the menu 
bar. Select one of the layout thumbnail images and click Apply. 
 
Reordering Slides 
 
To reorder a slide in Slide Sorter View, simply click on the slide you wish to move and 
drag it to the new location. In Normal or Outline View, click the slide icon  beside the 
number of the slide you want to move and drag the icon to a new location. 
 
Hide Slides 
 
If you do not want a slide to appear during the slide show, but do not want to delete the 
slide as it may be used later, the slide can be hidden by selecting Slide Show|Hide 
Slide from the menu bar. To add the slide back to the slide show, select Slide 
Show|Hide Slide again. 
 
Create a Custom Slide Show 
 
The Custom Slide Show feature allows you to select the slides you want to display in 
the slide show if not all the slides should be used. 
 
* Select Slide Show|Custom Slide Show from the menu bar. 
  
* Click the New... button in the Custom Shows window.  
 
* In the Define Custom Show window, type a name for the slide in the Slide 

show name field. 
  
* Add slides to the custom show by highlighting them in the Slides in 

presentation window and clicking the Add >> button. Those slides will then 
appear in the Slides in custom show window. 

* To remove slides from the custom show, highlight their names in the Slides in 
custom show window and click the Remove button. 

* To reorder slides in the custom show, highlight the slide that should be moved 
and click the up and down arrows to change its order in the show. 

* Click OK when finished. 
* Click the Show button on the Custom Shows window to preview the custom slide 

show and click Close to exit. 
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Edit a Custom Slide Show 
 
* Select Slide Show|Custom Slide Show from the menu bar. 
* Edit the show by highlighting the name in the Custom shows box and clicking 

the Edit... button. 
* To delete a show, highlight the name and click Remove. 
* Create a copy of a show by clicking the Copy button. The copy can then be 

renamed by clicking the Edit... button. 
* Click the Show button to preview the custom slide show and click Close to exit. 
 
Bulleted Lists on Design Templates 
 
Bulleted lists allow you to clearly display the main points of your presentation on slides. 
The text boxes on design templates already include bulleted lists. Click the place holder 
on the slide to begin adding text and press the ENTER key to return to the next line and 
add a new bulleted item. To go to the next line without adding another bullet, hold down 
the SHIFT key while pressing ENTER.  
 
Bulleted List from a Text Box 
 
If you are not creating a bulleted list from an existing placeholder on a design template, 
or if you would like to add an additional bulleted list, follow these steps to create a new 
list: 
 
* In slide view, create a text box by selecting Insert|Text Box from the menu bar. 
* "Draw" the text box on the slide by holding down the left mouse button while you 

move the mouse until the box is the size you want it. 
* Choose Format|Bullets and Numbering from the menu bar. 
* Change the Size of the bullet by changing the percentage in relation to the text. 
* Choose a color for the bullet from the Color menu. Click More Colors for a 

larger selection. 
* Select one of the seven bullet types shown and click OK. 
- OR - 

Click the Picture button to view the Picture Bullet window. Select one of the 
bullets and click OK. 

- OR - 
Click the Character button to select any character from the fonts on the 
computer. Select a symbol font such as Wingdings or Webdings from the Bullets 
from drop-down menu for the best selection of icons. Click on the characters in 
the grid to see them larger. Click OK when you have chosen the bullet you want 
to use. 

 
* Click OK on the Bullets and Numbering window and use the same methods 

described in the "Bulleted Lists on Design Templates" to enter text into the 
bulleted list. 
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Bulleted Lists and New Slides from an Outline 
 
In Normal or Outline view, text can easily be entered in the outline window and new 
slides are automatically added. Follow the steps below to become familiar with adding 
slide content in outline view: 
 
* Next to the Slide 1 icon, type the title of the slide. The text you type beside the 

slide icons will be the large-type titles on each slide. 
* Press ENTER to type the next line. This will automatically create a new slide. To 

create a bulleted list for the first slide, press the TAB key or click the demote 
button on the More Buttons menu accessible by clicking the "triple arrow" button 
at the end of the formatting toolbar. 

- OR - 
Press ALT+SHIFT+Right Arrow to demote the selection to a bulleted list item. 

* Continue entering text for the bulleted list, pressing ENTER at the end of each 
line to create a new bullet. 

* Create a multilevel list by executing the demote action again to create a bulleted 
sublist. Press the promote button on the More Buttons menu or press 
ALT+SHIFT+Left Arrow to return to the original list. 

* Create a new slide by executing the promote action until a new slide icon 
appears. 

* Continue creating new slides and bulleted lists by using the demote and promote 
actions until the presentation is completed. Use the formatting instructions below 
to format the lists. 

 
If there is more than one bulleted list on the slide, the lists will be designated by 
numbers enclosed in black boxes. The example below shows the slide created from the 
outline on the left. The bulleted list on the left side of the slide is labeled list "1" on the 
outline and the list on the right is labeled list "2". When typing the outline, begin typing in 
the new list by pressing CTRL+ENTER. In this example, CTRL+ENTER was pressed 
after typing "Access". 
 
Numbered List 
 
Follow these steps to create a numbered list: 
 
* Create a text box. 
* With the text box selected, choose Format|Bullets and Numbering from the 

menu bar. 
* Click the Numbered tab at the top of the Bullets and Numbering window. 
  
* Change the size of the numbers by changing the percentage in relation to the 

text. 
* Choose a color for the numbers from the Color menu. Click More Colors for a 

larger selection. 
* Change the Start at value if the numbers should not begin with 1. 

22 



T I L E  V  I N S T R U C T I O N A L  T E C H N O L G Y  M A N U A L  

* Select one of the seven list types shown and click OK. 
 
Resizing a Text Box 
 
Select a text box by clicking on it with the mouse. A border with nine handles will appear 
around the text box. The four handles on the corners will resize the length and the width 
of the box at once while the handles on the sides will resize only in one direction. Click 
one of the handles and drag it with the mouse. Release the mouse button when it is the 
size you want it to be. Move the text box by clicking and dragging the thick, dotted 
border with the mouse. 
 
Text Box Properties 
 
Change the colors, borders, and backgrounds of a text box from the Format 
AutoShape dialog box. 
 
* Activate the textbox by clicking on it and select Format|Colors and Lines from 

the menu bar. 
* Under the Colors and Lines tab, select a Fill color that will fill the background of 

the text box. Check the Semitransparent box if you want the slide background to 
show through the color. 

* Select a Line color that will surround the box as well as a Style or Weight for the 
thickness of the line and a Dashed property if the line should not be solid.  

* Click the Text Box tab.  
* Change the Text anchor point to reposition the text within the text box. 
* Set Internal margins to the distance the text should be to the text box edges. 
* Click OK to add the changes to the text box. 
 
Delete a Text Box 
 
To delete a text box from a template, simply click the border of the text box and press 
the DELETE key on the keyboard. 
 
Adding Notes 
 
From Normal View, notes can be added to the slide. These notes will not be seen on 
your presentation, but they can be printed out on paper along with the slide the notes 
refer to by selecting Print What: Notes Pages on the Print menu.  
 
Video 
 
To add a video to your presentation select Insert|Movies and Sounds|Movie from File 
or to insert an animation from Microsoft's gallery choose Insert|Movies and 
Sounds|Movie from Gallery. Select the video file and click OK. 
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Audio 
 
To add sound to your presentation select Insert|Movies and Sounds|Sound from 
Gallery or Sound from File. Select a sound file and click OK. 
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